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Name : Class :            Section : Roll No.

FORMATIVE ASSESSMENT - I
 Class - 2 :

REAL LIFE LEARN COMPUTERS
Time : 1 Hour Max. Marks : 25

25

C-19
Real Life

Learn Computers
Textbook

Syllabus:
(Chapter - 1)

(Pg. No.s : 5-7)

I. Fill in the blanks : (5 × 1 = 5)

1. The ...................................................... displays information.

2. The ................................................................. helps us to type letters and numbers.

3. ..................... is an order given to do some work.

4. C.P.U. stands for ..................................................

5. ........................... helps us to click icons.

II. Answer the following questions. (5 × 2 = 10)

1. How many parts does a computer consists of ?

2. Which part is known as the 'brain of the computer' ?

3. What is the use of keyboard ?

4. Which part helps us to move around the screen and click icons ?

5. From which word does the 'computer' derived from ?

III. Match the following. (5 × 1 = 5)

1. Mouse [ ] A) type the instruction

2. Keyboard [ ] B) display information

3. C.P.U. [ ] C) compute

4. Monitor [ ] D) click icons

5. Computer [ ] E) performs all the tasks

IV. Write 'yes' or 'no'. (5 × 1 = 5)

1. Icon is a symbolic representation of a program. [ ]

2. Computer makes our work easier. [ ]

3. Task is a fact provided on something. [ ]

4. C.P.U. performs all the tasks. [ ]

5. A standard keyboard consists of 100 keys. [ ]

❖❖❖❖❖
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I. Answer the following questions. (5 × 2 = 10)

1. Write any two input devices.

2. Explain about A.L.U.

3. What is output unit ?

4. What are the units present in C.P.U. ?

5. What is the use of directional keys ?

II. Match the following : (5 × 1 = 5)

1. C.P.U. [ ] A) Arithmetic and Logic unit

2. A.L.U. [ ] B) Output Unit

3. C.U. [ ] C) Memory Unit

4. O.U. [ ] D) Control Unit

5. M.U. [ ] E) Central Processing Unit

III. Fill in the blanks : (5 × 1 = 5)

1. Mouse is an example of ................. device.

2. ................. unit stores data and information.

3. ..................... key is used to move page upwards.

4. ................. key is used to erase a character backwards.

5. C.P.U. consists of ................. parts.

IV. Fill the missing letters : (5 × 1 = 5)

1. O  E R  T  O  S

2. E  C  P E

3. L  G  C  L

4. M   O  Y

5. F  N  T  O N A L

❖❖❖❖❖

Name : Class :            Section : Roll No.

FORMATIVE ASSESSMENT - II
 Class - 2

REAL LIFE LEARN COMPUTERS
Time : 1 Hour Max. Marks : 25

25Syllabus:
(Chapter - 2)

(Pg. No.s : 8-16)

1

C-19
Real Life

Learn Computers
Textbook

Learn Computers : FA - II
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C-19
Real Life

Learn Computers
Textbook

I. Fill in the blanks : (5 × 1 = 5)

1. Micro computers commonly refers to .......................... computers.

2. ......................... generation computers are still in development.

3. In second generation computers ................................... were used.

4. Analog computers use .................................... as input.

5. ................... possess large storage capacity.

II. Answer the following questions. (5 × 2 = 10)

1. Write about Super computers.

2. Into how many types does the Digital computers classified ?

3. Write about Micro computers.

4. How many generations does the evolution of computers classified ?

5. Write about fifth generation computers.

III. Match the following : (5 × 1 = 5)

1. Fourth generation [ ] A) High speed and large storage

capacity

2. Mini computers [ ] B) Signals

3. Second generation [ ] C) Vacuum tubes

4. Analog computers [ ] D) Transistor

5. First generation [ ] E) Micro Processors

IV. Fill the missing letters : (5 × 1 = 5)

1. D  G  T  L

2. D  V E   P  N G

3. M  C R  P   C E   O R

4. E  P E  S I  E

5. A  A L  G

❖❖❖❖❖

Name : Class :            Section : Roll No.

FORMATIVE ASSESSMENT - III
 Class - 2

REAL LIFE LEARN COMPUTERS
Time : 1 Hour Max. Marks : 25

25Syllabus:
(Chapter - 4,5)

(Pg. No.s : 22-32)

1 Learn Computers : FA - III
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I. Match the following : (5 × 1 = 5)

1. Menu's a) 4

b) 6

c) 5 Ans : ...............................

2. View Menu a) Menu bar

b) Page setup

c) Status bar Ans : ...............................

3. File Menu a) Select All

b) Print Preview

c) Cut Ans : ...............................

4. Menu bar a) Image

b) Paste

c) Programs Ans : ...............................

5. Edit Menu a) Tool Box

b) Clear Selection

c) Print Ans : ...............................

II. Answer the following questions. (5 × 2 = 10)

1. What are the menu's present in Menu Bar ?

2. Write the options present in Edit Menu.

3. What are the steps to open Ms-Paint ?

4. Write the options of View Menu.

5. What are the options are there in File Menu ?

III. Fill in the blanks : (5 × 1 = 5)

1. ........................... option is used to maximize or minimize the selected part.

2. .................................................... option is used to cancel undo action.

Name : Class :            Section : Roll No.

FORMATIVE ASSESSMENT - IV
 Class - 2

REAL LIFE LEARN COMPUTERS
Time : 1 Hour Max. Marks : 25

25

1 Learn Computers : FA - IV

C-19
Real Life

Learn Computers
Textbook
Syllabus:

(Chapter - 7)
(Pg. No.s : 37-41)

✁
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3. ..................................................... option is used to preview of the file before printing.

4. .................................................... option is used to open an already existing option.

5. .................................................................. option is used to exit from Ms-Paint.

IV. Write 'Yes' or 'No' : (5 × 1 = 5)

1. Print option is used to exit from Ms-Paint. [ ]

2. Copy is used to cut the selected part. [ ]

3. Save is used to save the already saved file with another name. [ ]

4. Redo is used to cancel the undo action. [ ]

5. Tool box consists of tools. [ ]

❖❖❖❖❖

2 Learn Computers : FA - IV
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Name : Class :            Section : Roll No.

SUMMATIVE ASSESSMENT - I
 Class - 2

REAL LIFE LEARN COMPUTERS
Time : 2½ Hours Max. Marks : 50

50

I. Answer any ONE of the following questions. (1 × 5 = 5)

1. Explain about the Arithmetic and Logic unit / Memory Unit.

2. What are the five advantages of a computer ?

II. Answer the following questions. (5 × 3 = 15)

1. Explain about control unit.

2. How many instructions can a computer carry in one second ?

3. How many parts does a computer consists of ?

4. How does a computer work ? Fast or slow ?

5. Explain about the :

1) Shift keys 2)Caps Lock

III. Write the missing letters. (5 × 2 = 10)

1. S T _ R _ G E

2. A _ C _ R _ _ Y

3. C _ M _ _ T _ R

4. S P _ _ D

5. I _ P _ T

IV. Fill in the blanks. (5 × 1 = 5)

1. The operations such as Addition, Subtraction are done by .............. unit.

2. Computer carries out ..................... correctly.

3. ............................ key is used to erase a character backwards.

4. The ........................ is the brain of the computer.

5. Computers always produce correct ....................

1 Learn Computers : SA - I

C-19
Real Life

Learn Computers
Textbook
Syllabus:

(1 - 3 Chapters)
(Pg. No.s : 5-21)

✁
✁
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V. Choose the correct answer. (5 × 1 = 5)

1. ................ key is used to bring the cursor to the end of the line at a time. [ ]

A) End B) Delete C) Alt D) Escape

2. Computer consists of ................. parts. [ ]

A) 3 B) 4 C) 5 D) None of these

3. ............... is the brain of the computer. [ ]

A) A.L.U. B) M.U. C) C.U. D) C.P.U.

4. ..................... is an example of input device. [ ]

A) Scanner B) Monitor C) Printer D) None of these

5. A.L.U. performs [ ]

A) Arithmetic B) Logical C) Both A & B D) None of these

VI. Match the following. (5 × 2 = 10)

A B

1. Symbol keys [ ] A) special functions

2. Home key [ ] B) carry millions of instructions in one

second

3. Output Unit [ ] C) beginning of the line

4. Functional keys [ ] D) @, #, $

5. Speed [ ] E) see the results of processed data

❖❖❖❖❖

2 Learn Computers : SA - I
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I. Answer any ONE of the following questions. (1 × 5 = 5)

1. Write about fourth generation computers.

2. Write the advantages of a computer.

II. Fill in the blanks. (5 × 1 = 5)

1. The first generation is from ................ to .............. .

2. In third generation computers .................... were used.

3. ............. possess large storage capacity.

4. ................. generation computers are still in development.

5. After you complete your work you must .................... your computer.

III. Answer the following questions. (5 × 3 = 15)

1. How many generations does the evolution of computers classified ?

2. Explain about :

1) Page up 2) Arrow keys and 3) Caps Lock

3. Write about Super computers.

4. How can we shutdown the computer ?

5. Into how many types does the Digital computers classified ?

IV. Write the missing letters. (5 × 2 = 10)

1. D  V E   P  N G

2. V  C   M T  B  S

3. S T  R  G E

4. C  R C   T S

5. M  C R 

Name : Class :            Section : Roll No.

SUMMATIVE ASSESSMENT - II
 Class - 2

REAL LIFE LEARN COMPUTERS
Time : 2½ Hours Max. Marks : 50

50

1

C-19
Real Life

Learn Computers
Textbook

Syllabus:
(1 - 6 Chapters)

(Pg. No.s : 5 - 36 )

Learn Computers : SA - II

✁
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V. Choose the correct answer. (5 × 1 = 5)

1. Computers are classified into ................ categories. [ ]

A) Two B) Three C) Four D) Five

2. Micro processor chip contains thousands of [ ]

A) I.C'S B) Disks C) Transistors D) Vacuum Tubes

3. The computers which use signals as input [ ]

A) Analog computers B) Digital computers

C) Mini computers D) Super computers

4. The Fourth Generation computers are made up of [ ]

A) Vacuum Tubes B) Transistors C) IC's D) Micro processor chips

5. The third generation is from [ ]

A) 1959 – 1964 B) 1951 – 1958 C) 1965 – 1970 D) 1971 – 1976

VI. Match the following. (5 × 2 = 10)

A B

1. Fourth generation [ ] A) Compute

2. Computer [ ] B) Micro processors

3. Switch off [ ] C) Digits

4. Start [ ] D) Shutting down

5. Digital computers [ ] E) Desktop

❖❖❖❖❖

2 Learn Computers : SA - II
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I. Answer the following questions. (5 × 3 = 15)

1. How can we shutdown the computer ?

2. Does a computer make mistake ?

3. Write the options present in Edit Menu.

4. Explain about vacuum tubes.

5. What is Hardware ?

II. Answer any ONE of the following questions. (1 × 5 = 5)

1. What are the menu's present in Menu Bar ?

2. Give three examples of Hardware and Software.

III. Fill in the blanks : (5 × 1 = 5)

1. Computers can store large amount of ....................

2. We can feel, touch or see the ....................

3. The .................... displays information.

4. Digital computers represent data in the form of ....................

5. We must follow the rules for .................... use of ....................

IV. Write the missing letters. (5 × 2 = 10)

1. A _ P _ I _ A T I _ N

2. C _ M _U _ E R

3. D _ V E _ _ P _ N G

4. S _ F T W _ R _

5. A C _ U _ A C _

Name : Class :            Section : Roll No.

SUMMATIVE ASSESSMENT - III
 Class - 2

REAL LIFE LEARN COMPUTERS
Time : 2½ Hours Max. Marks : 50

50

1

C-19
Real Life

Learn Computers
Textbook

Syllabus:
(Chapters 1 to 8)
(Pg. No.s : 5 - 46)

Learn Computers : SA - III

✁
✁
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V. Match the following. (5 × 2 = 10)

A B

1. Switch off [ ] A) Cancel Undo reaction

2. Clear all [ ] B) Software

3. Windows [ ] C) Software

4. Cannot feel or touch [ ] D) Deletes the text

5. Redo [ ] E) Shutting down

VI. Choose the correct answer. (5 × 1 = 5)

1. Example of software is .......... [ ]

A) MS – paint B) MS – office C) Windows D) File Menu

2. It is used to give space between the words. [ ]

A) Space bar B) Back space C) Home key D) Escape key

3. This is an example of output device. [ ]

A) Keyboard B) Mouse C) Scanner D) Printer

4. Which of the following key never does anything on its own ? [ ]

A) Shift B) End C) Home D) Alt

5. Menu Bar consists of ........... [ ]

A) New B) Undo C) Color box D) File Menu

❖❖❖❖❖

2 Learn Computers : SA - III


